Contents

Preface ........................................................................................................vii
  About This Guide ............................................................................. vii
  Intended Audience ......................................................................... vii
  Document Feedback ........................................................................ vii
  VMware Infrastructure Documentation ....................................... vii
  Conventions and Abbreviations ...................................................... viii
    Abbreviations ............................................................................... viii
  Technical Support and Education Resources ............................... ix
    Self-Service Support .................................................................... ix
    Online and Telephone Support .................................................... ix
    Support Offerings ....................................................................... ix
    VMware Education Services ....................................................... x

Chapter 1 Introducing VMware Virtual Infrastructure
Web Access ........................................................................................ 1
  What Is Virtual Infrastructure Web Access? ................................. 1
  Key Features .................................................................................. 2
    Virtual Machine Management ................................................... 2
    Remote Virtual Machine Console URLs .................................. 2
    Usability ...................................................................................... 2
    Simplified Remote Console Use ................................................. 2

Chapter 2 System Requirements and Web Browser
Configuration ...................................................................................... 3
  Virtual Infrastructure Web Access Requirements ......................... 3
  System Requirements ...................................................................... 3
    PC Hardware ............................................................................. 3
    Operating Systems .................................................................... 4
  Browser Requirements .................................................................... 4
  Installing Virtual Infrastructure Web Access .................................. 4
  Running and Configuring Virtual Infrastructure Web Access Service .......... 5
### Chapter 3 Getting Started with Virtual Infrastructure Web Access

- Connecting to Virtual Infrastructure Web Access .............................................. 9
- Logging Out .................................................................................................. 10
- Overview of the Virtual Infrastructure Web Access Default View .............. 10
  - Workspace ............................................................................................. 12
  - Menu Bar ............................................................................................... 13
  - Web Access Menu .................................................................................. 13
  - View Menu .............................................................................................. 14
  - Virtual Machine Menu .............................................................................. 15
- Toolbar ........................................................................................................ 15
- Inventory Panel ............................................................................................ 17

### Chapter 4 Using Virtual Infrastructure Web Access to Manage Virtual Machines

- Summary, Events, Alarms, Tasks, and Console Views .................................. 20
- Viewing Summary Information About Virtual Machines .......................... 21
- Viewing Virtual Machine Events ................................................................. 22
- Viewing Virtual Machine Alarms ................................................................. 23
- Viewing Virtual Machine Tasks ................................................................. 24
- Using the Console ......................................................................................... 24
  - Entering Full Screen Mode .................................................................... 27
- Installing VMware Tools in the Guest Operating System ....................... 27
- Changing the Power State of a Virtual Machine ........................................ 28
- Creating and Sharing Remote Console URLs .......................................... 29

### Chapter 5 Editing an Existing Virtual Machine’s Configuration

- Editing the Configuration of Existing Virtual Machines .......................... 31
- Understanding Permissions and Virtual Machines .................................... 31
- Editing the Hardware Configuration of a Virtual Machine ........................ 32
  - Editing Processors ............................................................................... 32
  - Editing or Removing a CD/DVD Drive .................................................. 33
Preface

This preface describes the contents of this manual, lists related documentation, describes document conventions, and provides additional references for support. This preface contains the following topics:

- “About This Guide” on page vii
- “Intended Audience” on page vii
- “Document Feedback” on page vii
- “VMware Infrastructure Documentation” on page vii
- “Conventions and Abbreviations” on page viii
- “Technical Support and Education Resources” on page ix

About This Guide

This manual, the Virtual Infrastructure Web Access Administrator’s Guide, provides information on how to configure virtual machines for ESX Server and VirtualCenter Server.

Intended Audience

The information presented in this manual is written for experienced system administrators who are familiar with Windows or Linux virtual machine technology and datacenter operations.

Document Feedback

If you have comments about this documentation, submit your feedback to:

docfeedback@vmware.com

VMware Infrastructure Documentation

The VMware Infrastructure documentation consists of the combined VirtualCenter and ESX Server documentation set.
You can access the books in the VMware Infrastructure document set at:

http://www.vmware.com/support/pubs

Conventions and Abbreviations

This manual uses the style conventions listed in Table P-1.

Table P-1. Type Conventions

<table>
<thead>
<tr>
<th>Style</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monospace</td>
<td>Used for commands, filenames, directories, paths.</td>
</tr>
<tr>
<td>Monospace bold</td>
<td>Used to indicate user input.</td>
</tr>
<tr>
<td>Bold</td>
<td>Used for these terms:</td>
</tr>
<tr>
<td></td>
<td>Interface objects, keys, buttons</td>
</tr>
<tr>
<td></td>
<td>Items of highlighted interest</td>
</tr>
<tr>
<td></td>
<td>Glossary terms</td>
</tr>
<tr>
<td>Italic</td>
<td>Used for book titles.</td>
</tr>
<tr>
<td>&lt; name &gt;</td>
<td>Used to indicate variable and parameter names.</td>
</tr>
</tbody>
</table>

Abbreviations

The graphics in this manual use the abbreviations listed in Table P-2.

Table P-2. Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC</td>
<td>VirtualCenter</td>
</tr>
<tr>
<td>VI</td>
<td>Virtual Infrastructure Client</td>
</tr>
<tr>
<td>server</td>
<td>VirtualCenter server</td>
</tr>
<tr>
<td>database</td>
<td>VirtualCenter database</td>
</tr>
<tr>
<td>hostr</td>
<td>VirtualCenter managed hosts</td>
</tr>
<tr>
<td>VM#</td>
<td>virtual machines on a managed host</td>
</tr>
<tr>
<td>user#</td>
<td>user with access permissions</td>
</tr>
<tr>
<td>dsk#</td>
<td>storage disk for the managed host</td>
</tr>
<tr>
<td>datastore</td>
<td>storage for the managed host</td>
</tr>
<tr>
<td>SAN</td>
<td>storage area network type datastore shared between managed hosts</td>
</tr>
<tr>
<td>tmplt</td>
<td>template</td>
</tr>
</tbody>
</table>
Technical Support and Education Resources

The following sections describe the technical support resources available to you:

- “Self-Service Support” on page ix
- “Online and Telephone Support” on page ix
- “Support Offerings” on page ix
- “VMware Education Services” on page x

Self-Service Support

Use the VMware Technology Network for self-help tools and technical information:


For more information about the VMware Technology Network, go to [http://www.vmtw.net](http://www.vmtw.net).

Online and Telephone Support

Use online support to submit technical support requests, view your product and contract information, and register your products. Go to [http://www.vmware.com/support](http://www.vmware.com/support).

For customers with appropriate support contracts, use telephone support for the fastest response on priority 1 issues. Go to [http://www.vmware.com/support/phone_support.html](http://www.vmware.com/support/phone_support.html).

Support Offerings

Find out how VMware's support offerings can help you meet your business needs. Go to [http://www.vmware.com/support/services](http://www.vmware.com/support/services).
VMware Education Services
VMware courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. For more information about VMware Education Services, go to http://mylearn1.vmware.com/mgrreg/index.cfm.
CHAPTER 1  Introducing VMware Virtual Infrastructure Web Access

This chapter introduces Virtual Infrastructure (VI) Web Access components and operations. This chapter contains the following topics:

- “What Is Virtual Infrastructure Web Access?” on page 1
- “Key Features” on page 2

What Is Virtual Infrastructure Web Access?

VI Web Access is a browser-based application designed to manage virtual machines on ESX Server and VirtualCenter deployments. This version of VI Web Access focuses on virtual machine management, and pays attention to:

- System administrators who need to access virtual machines without a VI Client
- People who use virtual machines as remote desktops
- Virtual Infrastructure administrators who need to interact with virtual machines remotely

The VI Web Access interface provides a powerful overview of all the virtual machines on an ESX Server system and VirtualCenter Server. Using Virtual Infrastructure Web Access to manage virtual machines, you can:

- View hosts and the virtual machine details using a Web browser
- Perform power operations on virtual machines
- Edit a virtual machine’s configuration and hardware
- Generate URL shortcuts that others can use to access virtual machines
- Interact with the guest operating systems running within the virtual machines

VI Web Access focuses on virtual machine management, and does not offer the full range of administrative tasks available through the VI Client.
Key Features

The key features of VI Web Access 1.0 are described below.

Virtual Machine Management

Users can access virtual machine status information and power controls by connecting directly to an ESX Server host or a VirtualCenter Server.

Users can use the mouse, keyboard, and screen, including full screen mode, of any virtual machine from any compatible Web browser.

Remote Virtual Machine Console URLs

Users can share virtual machines with customized controls and environments using ordinary Web browser URLs.

Each URL provides direct access to a specific virtual machine from virtually any Web browser.

Usability

Administrators can provide end users with access to virtual machines.

Users can access virtual machines on ESX Server hosts and VirtualCenter Servers without installing the Virtual Infrastructure client.

Client devices allow people to use floppy and CD/DVD drives from their own computers to install software or copy data. Accessing the drives on their ESX Server hosts is not required.

Simplified Remote Console Use

People can complete their work without distractions by customizing remote console URLs that present only as many user interface controls as necessary.
CHAPTER 2  System Requirements and Web Browser Configuration

This chapter introduces VI Web Access components and operations. This chapter contains the following topics:

- “Virtual Infrastructure Web Access Requirements” on page 3
- “Installing Virtual Infrastructure Web Access” on page 4
- “Running and Configuring Virtual Infrastructure Web Access Service” on page 5
- “Setting Virtual Infrastructure Web Access Passwords” on page 6
- “Installing the VMware Virtual Infrastructure Web Access Plug-In” on page 6

Virtual Infrastructure Web Access Requirements

The following sections outline the system and browser requirements for using VI Web Access:

- “System Requirements” on page 3
- “Browser Requirements” on page 4

System Requirements

PC Hardware

- Standard x86-based computer
- 266MHz processor minimum (500MHz or faster recommended)
- 128MB RAM minimum (256MB or more recommended)
- 20MB (for Windows hosts) or 10MB (for Linux hosts) free disk space to install the VMware Virtual Infrastructure plug-in
Operating Systems

Windows

- Windows XP Professional or Windows XP Home Edition with Service Pack 2

Linux

- Linux kernel 2.2.14 or higher
- glibc 2.3.2 or higher
- XFree86-3.3.6 or higher
- gtk+2.0 or higher
- fontconfig (also known as xft)
- libstdc++5 or higher

Browser Requirements

To access VMware Virtual Infrastructure Web Access, you should be running one of the following:

- Internet Explorer 6.0
- Mozilla Firefox for Microsoft Windows 1.0.8 or higher
- Mozilla Firefox for Linux 1.0.8 or higher

NOTE Other browsers are not actively excluded, but VMware has certified VI Web Access with only the browsers listed above. Please refer to your browser vendor’s own documentation for additional requirements. For the best experience, make sure your browser includes all of the security and stability updates recommended by its vendor.

Installing Virtual Infrastructure Web Access

VI Web Access is automatically installed when ESX Server is installed. On VirtualCenter Server, VI Web Access can be installed from the VirtualCenter Server Windows setup package.
Running and Configuring Virtual Infrastructure Web Access Service

To connect to an ESX Server host or VirtualCenter Server with VI Web Access, the VI Web Access service must be running on the host or server.

Running VI Web Access on ESX Server

By default, ESX is configured to connect to VI Web Access whenever the host is powered on. If you are unable to connect to your ESX Server host using VI Web Access, you might need to restart the VI Web Access service on your host.

To troubleshoot VI Web Access service on an ESX Server host

1. Log directly into your ESX Server service console.
2. Enter `service vmware-webAccess status` to check the status of the host’s VI Web Access service.
3. If VI Web Access service is stopped, enter `service vmware-webAccess start`.

Running VI Web Access on VirtualCenter Server

When connected to a VirtualCenter Server, VI Web Access is a Web application running under a Tomcat Web server.

To configure a Tomcat server

1. Open the Windows Start menu.
2. Click Programs.
3. Click VMware.
4. Click VMware Web Access.
5. Click Configure Tomcat.

Instructions on configuring Tomcat can be found at [http://tomcat.apache.org/tomcat-5.5-doc/index.html](http://tomcat.apache.org/tomcat-5.5-doc/index.html).
Setting Virtual Infrastructure Web Access Passwords

Administrators must have a valid user name and password to access ESX Server hosts and VirtualCenter Servers using VI Web Access. The password defaults are as follows:

- **ESX Server** — The default user is root. The root password is configured during the installation of ESX Server.
- **VirtualCenter Server** — The default user is Administrator. The Administrator password is configured during the installation of VirtualCenter Server.

Administrators can add users and groups to allow users access to VI Web Access.

For more information on setting passwords during installation, refer to the *VMware ESX Server Installation Guide*.

Installing the VMware Virtual Infrastructure Web Access Plug-In

To run VI Web Access, you must install the VMware Virtual Infrastructure plug-in.

Before you can install the VMware Virtual Infrastructure plug-in for Mozilla Firefox, you must configure Firefox to recognize your VI Web Access host.

**To install VMware Virtual Infrastructure ActiveX Control in Microsoft Internet Explorer**

1. In the Internet Explorer window, type the VI Web Access URL:

   `<https://vmwarehost.yourdomain.com/ui>`

2. Log in to VI Web Access using the user name and password for the host to which you are connecting.

3. Select a virtual machine from the Virtual Machines list.

4. Click the *Console* tab.

   If prompted, click *Install* in the pop-up box. You may need to refresh your browser after installation.

**To configure Mozilla Firefox for Windows to recognize your host**

1. Launch Firefox.

2. In the Firefox window, choose *Tools > Options* to open the Options control panel.

3. Click the *Content* tab.

4. Click *Web Features*.

5. Click *Allowed Sites*.
Chapter 2 System Requirements and Web Browser Configuration

6 In the Address of web site entry field, type:
   <vmwarehost.yourdomain.com>

7 Click Allow.

8 Click Close.

To install the VMware Virtual Infrastructure plug-in in Mozilla Firefox for Windows

1 In the Firefox window, type the VI Web Access URL:
   <https://vmwarehost.yourdomain.com/ui>

2 Log in to VI Web Access using the user name and password for the host to which
   you are connecting.

3 Select a virtual machine from the Virtual Machines list.

4 Click the Console tab.

5 Click Install Plugin.
   The software installation dialog box appears.

6 Click Install Now.

7 After the installation is complete, choose View > Reload to reload the page.

To configure Mozilla Firefox for Linux to recognize your host

1 Launch Firefox.

2 In the Firefox window, choose Edit > Preferences to open the Preferences control
   panel.

3 Click the Content tab.

4 Click Web Features.

5 Click Allowed Sites.

6 In the Address of web site entry field, type:
   <vmwarehost.yourdomain.com>

7 Click Allow.

8 Click Close.
To install the VMware Virtual Infrastructure plug-in in Mozilla Firefox for Linux

1. In the Firefox window, type the VI Web Access URL:
   <https://vmwarehost.yourdomain.com/ui>
2. Log in to VI Web Access using the user name and password for the host to which you are connecting.
3. Select a virtual machine from the Virtual Machines list.
4. Click the Console tab.
5. Click Install Plugin.
   The software installation dialog box appears.
6. Click Install Now.
7. After the installation is complete, choose View > Reload to reload the page.

To troubleshoot the plug-in installation

2. Launch Firefox again.
3. In the Firefox window, type the VI Web Access URL:
   <https://vmwarehost.yourdomain.com/ui>
4. Select a virtual machine from the Virtual Machines list.
5. Click the Console tab.
6. When you are prompted to install the plug-in, click OK.
7. After the installation is complete, choose View > Reload to reload the page.
CHAPTER 3  Getting Started with Virtual Infrastructure Web Access

This chapter guides you through the basic tasks you must complete to begin using VI Web Access.

This chapter includes the following topics:

- “Connecting to Virtual Infrastructure Web Access” on page 9
- “Logging Out” on page 10
- “Overview of the Virtual Infrastructure Web Access Default View” on page 10

Connecting to Virtual Infrastructure Web Access

After your user name and password are authorized by VI Web Access, the VI Web Access home page appears. The VI Web Access home page contains:

- High-level details about all the virtual machines on the server to which you are connected

- The option to access the details page for a virtual machine where you find information about virtual devices, configuration options, and a summary of recent events
To log in to VI Web Access

1. Launch your Web browser.
2. Enter the URL of your ESX Server or your VirtualCenter Server installation:
   https://<host or server name>/ui
   The Web Access login page appears.
3. Enter your user name and password, and click Log In.
   The VI Web Access home page appears. For information about the Status Monitor
   page, see “Overview of the Virtual Infrastructure Web Access Default View” on
   page 10.
   To log out of VI Web Access, see “Logging Out” on page 10.

Logging Out

You can log out of VI Web Access by clicking the Log Out link found at the upper-right
corner of every page. You are prompted to confirm that you want to log out.
Logging out disconnects client devices that any of the virtual machines are using.

Overview of the Virtual Infrastructure Web Access
Default View

The following sections describe the VI Web Access interface and components:
- “Workspace” on page 12
- “Menu Bar” on page 13
- “Toolbar” on page 15
- “Inventory Panel” on page 17
The VI Web Access default view contains a high-level view of the ESX Server or VirtualCenter Server that you are logged in to, including a list of all registered virtual machines and their status.

Figure 3-1. Web Access Home Page View

The VMware VI Web Access window is divided into four main sections:

- **Workspace** — Appearing on the right, this is the main part of the window. When the host (ESX Server) or a datacenter or folder (VirtualCenter Server) is selected in the inventory panel (see below), you can view a list of all the virtual machines contained by the selected object. When a virtual machine is selected, the workspace provides detailed information about various aspects of the virtual machine.

- **Menu bar** — The menu items along the top of the VI Web Access window provide access to common virtual machine operations, such as power on and enter full screen mode.

- **Toolbar** — These buttons along the top allow you to act on the selected virtual machine, offering one-click access to operations such as power on and enter full screen mode.
Inventory panel — Appearing on the left, this area displays a list of virtual machines (ESX Server) or the virtual machine hierarchical inventory (VirtualCenter Server). Click a virtual machine to display information about the virtual machine and available options for the virtual machine.

Workspace

When you select a virtual machine, the workspace provides detailed information about various aspects of the virtual machine. You can view a summary of the virtual machine’s state, interact with the guest operating system using a remote mouse-keyboard-screen (MKS), and view details about alarms (VirtualCenter), events, and tasks (VirtualCenter).

![Virtual Machine Information Panel](image)

Figure 3-2. Virtual Machine Information Panel

NOTE Administrators can configure a URL for any virtual machine that displays only the remote Console tab, hiding and disabling the workspace tabs and inventory panel. See “Creating and Sharing Remote Console URLs” on page 29 for more information.
Menu Bar

The menu bar provides access to all commands.

![Web Access Menu Bar](image)

**Figure 3-3. Web Access Menu Bar**

The menu bar options are:

- **Web Access menu** — Displays options relevant to VI Web Access.
- **View menu** — Controls which panes are visible.
- **Virtual Machine menu** — Is enabled only when a virtual machine is selected in the inventory panel.

The Web Access menu bar options are covered in the following sections:

- “Web Access Menu” on page 13
- “View Menu” on page 14
- “Virtual Machine Menu” on page 15

Web Access Menu

The **Web Access** menu lists general VI Web Access options for getting help and logging out.

![Web Access Menu](image)

**Figure 3-4. Web Access Menu**

- **About** — Displays the Web Access version number, the host agent version number, and VMware copyright information.
- **Help** — Displays the online help contents.
- **Log Out** — Logs you out of VI Web Access.
View Menu

The virtual machine View menu lists options for managing inventory and tab views on the VI Web Access home page.

![Image of Web Access View Menu]

**Figure 3-5. Web Access View Menu**

Inventory View Options

The inventory panel displays a list of inventory objects. Display options include:

- **Expand Sidebar** — Expands the inventory panel.
- **Collapse Sidebar** — Collapses the inventory panel. When collapsed, the inventory panel is a strip along the left side of the VI Web Access window. Click the arrows in the strip to expand or collapse the inventory panel.
- **Hide Sidebar** — Hides the inventory panel. When the inventory panel is hidden, you cannot access the inventory panel unless you deselect this view option.

Virtual Machine Tab View Options

The virtual machine tabs appear at the bottom of the information panel. Display options include:

- **Show Tabs** — Displays the Summary, Events, Alarms (VirtualCenter only), Tasks (VirtualCenter only), and Console tabs for the virtual machine.
- **Hide Tabs** — Hides the Summary, Events, Alarms (VirtualCenter only), Tasks (VirtualCenter only), and Console tabs for the virtual machine.
Virtual Machine Menu

The Virtual Machine menu lists options for managing the power state of a virtual machine and for viewing the console.

- **Power On** — Powers on a stopped virtual machine.
- **Resume** — Resumes a suspended virtual machine.
- **Power Off** — Powers off the virtual machine immediately. This is the same as turning off the power to a physical computer.
- **Suspend** — Suspends a powered-on virtual machine.
- **Reset** — Resets the virtual machine immediately. This is the same as pressing the reset button on a physical computer.
- **Shutdown Guest** — Shuts down the guest operating system and powers off the virtual machine.
- **Restart Guest** — Restarts the guest operating system and the virtual machine.

Toolbar

The toolbar at the top of the VI Web Access page contains buttons you can click to power your virtual machines on and off.
The following table describes the toolbar actions.

<table>
<thead>
<tr>
<th>Button</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power Off" /></td>
<td>Powers off the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server might shut down the guest operating system before powering off the virtual machine (see “Changing Power State Options” on page 62). When this icon is red, the virtual machine is powered off.</td>
</tr>
<tr>
<td><img src="image" alt="Suspend" /></td>
<td>Suspends a running virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is amber, the virtual machine is suspended.</td>
</tr>
<tr>
<td><img src="image" alt="Power On" /></td>
<td>Powers on a stopped virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is green, the virtual machine is running.</td>
</tr>
<tr>
<td><img src="image" alt="Reset" /></td>
<td>Resets the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server might shut down the guest operating system before resetting the virtual machine (see “Changing Power State Options” on page 62).</td>
</tr>
<tr>
<td><img src="image" alt="Maximize Display" /></td>
<td>Enlarges the virtual machine display to cover the entire Web Access window. This option is enabled only when a virtual machine is running and the Console tab is selected.</td>
</tr>
</tbody>
</table>
Inventory Panel

This panel displays the virtual machine inventory. You can collapse and expand the inventory panel with a single click.

**NOTE** Administrators can configure a URL that does not show the inventory panel.

*Figure 3-8. Virtual Machine Inventory*
CHAPTER 4 Using Virtual Infrastructure
Web Access to Manage Virtual Machines

This chapter describes the various aspects of using VI Web Access to manage virtual machines. This chapter contains the following sections:

- “Summary, Events, Alarms, Tasks, and Console Views” on page 20
- “Viewing Summary Information About Virtual Machines” on page 21
- “Viewing Virtual Machine Events” on page 22
- “Viewing Virtual Machine Alarms” on page 23
- “Viewing Virtual Machine Tasks” on page 24
- “Using the Console” on page 24
- “Installing VMware Tools in the Guest Operating System” on page 27
- “Changing the Power State of a Virtual Machine” on page 28
- “Creating and Sharing Remote Console URLs” on page 29
Summary, Events, Alarms, Tasks, and Console Views

The workspace, which appears on the right side of the VI Web Access display, displays information about the selected virtual machine divided into multiple tabs.

- **Summary** — Displays performance and status information. From this tab, you can modify the selected virtual machine's hardware and configuration options.
- **Events** — Displays events that occurred for the virtual machine. Select an event to see its details in the Event Details field.
- **Alarms** — Displays alarms. This tab is available only through VirtualCenter Server.
- **Tasks** — Displays activities and activity details. This tab is available only through VirtualCenter Server. Tasks can be initiated manually or scheduled using the VI Client.
- **Console** — Allows users to interact directly with the guest operating system. See “Using the Console” on page 24.
Viewing Summary Information About Virtual Machines

When you select the Summary tab for a virtual machine, VI Web Access displays a summary of the configuration information about that virtual machine.

- Average amount of server processor capacity that the virtual machine used in the previous five minutes.
- Amount of server memory that the virtual machine is currently using.
- Current power state of the virtual machine: whether it is powered on, powered off, or suspended. For more information, see “Changing the Power State of a Virtual Machine” on page 28.
- Guest operating system installed in the virtual machine.
- VMware Tools status, indicating whether VMware Tools is installed and running. For more information, see “Installing VMware Tools in the Guest Operating System” on page 27.
Virtual Infrastructure Web Access Administrator’s Guide

- IP address and DNS name of the virtual machine.
- Links to edit or remove the virtual machine’s hardware. To change most options, you must power off the virtual machine. For more information, see “Editing the Hardware Configuration of a Virtual Machine” on page 32.
- Links to add hardware to the virtual machine. For more information, see “Adding Hardware to a Virtual Machine” on page 45.
- Links to edit the virtual machine’s standard configuration options. To change most options, you must power off the virtual machine. For more information, see “Changing Virtual Machine Options” on page 61.
- Link to create a remote console URL of the virtual machine. For more information, see “Creating and Sharing Remote Console URLs” on page 29.
- Current relationships of the virtual machine: the name of the virtual machine’s host, datastores, and networks.
- Recent tasks and alarms for the virtual machine, when you are using VI Web Access to connect to a VirtualCenter Server.

Viewing Virtual Machine Events

The Events tab is available when you select a virtual machine from the inventory panel.

![Virtual Machine > Events Tab](figure.png)

**Figure 4-3. Virtual Machine > Events Tab**

The Events list displays a sorted log of the most recent virtual machine transactions, such as questions ESX Server asks, errors, and other events like powering on or powering off the virtual machine.
You can sort events by clicking on the column headers. By default, events appear in reverse chronological order.

The event log draws its data from the log file for the virtual machine’s configuration file. The log file is stored, by default, in the directory where the virtual machine is stored.

The **Events** tab content is described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered</td>
<td>Date and time the event occurred.</td>
</tr>
<tr>
<td>Triggered By</td>
<td>Entity that triggered the event.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of event that occurred.</td>
</tr>
<tr>
<td>Message</td>
<td>Text explanation of action.</td>
</tr>
</tbody>
</table>

**Viewing Virtual Machine Alarms**

If you are using VI Web Access to connect to a VirtualCenter Server, the **Alarms** tab is available when you select a virtual machine from the inventory panel. Alarms are notifications that are triggered when specified events happen to a virtual machine, such as CPU usage exceeding the designated usage.

<table>
<thead>
<tr>
<th>Summary</th>
<th>Events</th>
<th>Alarms</th>
<th>Tasks</th>
<th>Console</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Triggered</td>
<td>Y</td>
<td>Status</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>6/5/06 1:03:03 PM PDT</td>
<td>Virtual Machine Memory Usage</td>
<td>Status</td>
<td>Default alarm to monitor virtual machine memory usage</td>
<td></td>
</tr>
<tr>
<td>6/5/06 1:03:03 PM PDT</td>
<td>Virtual Machine CPU Usage</td>
<td>Name</td>
<td>Default alarm to monitor virtual machine CPU usage</td>
<td></td>
</tr>
</tbody>
</table>

The **Alarms** tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Triggered</td>
<td>Date and time the alarm was most recently triggered.</td>
</tr>
<tr>
<td>Status</td>
<td>Severity of the alarm.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the alarm.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the alarm.</td>
</tr>
</tbody>
</table>
Virtual Infrastructure Web Access Administrator’s Guide

Viewing Virtual Machine Tasks

If you are using VI Web Access to connect to a VirtualCenter Server, the Tasks tab is available when you select a virtual machine from the inventory panel. Tasks are high-level actions, such as powering on a virtual machine, that are performed manually by a user or automatically on a schedule. Click a task’s triggered date and time to display its details, including related events, in the Task Details section.

The Task tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered</td>
<td>Date and time the task started.</td>
</tr>
<tr>
<td>Triggered By</td>
<td>User or entity that initiated the task.</td>
</tr>
<tr>
<td>Status</td>
<td>The state of the task: queued, in progress, error, or success.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the task.</td>
</tr>
</tbody>
</table>

Using the Console

The Console tab is available when you select a virtual machine from the inventory panel. If you need to interact with the guest operating system running in a virtual machine, use the Console tab to connect remotely to the virtual machine’s mouse, keyboard, and screen (MKS).
When a virtual machine is powered off, suspended, or not available, or if the MKS plug-in is not installed, the Console tab displays a message and possible actions for the virtual machine.

Virtual machine states include:

- **Powered Off** — Provides the option to power on the virtual machine.
- **Suspended** — Provides the option to resume the virtual machine.
- **Not Available** — Provides the option to try again.

When the virtual machine is powered on, the **Console** tab displays the MKS of the virtual machine.
To interact with the guest operating system using your mouse or keyboard, click the virtual machine’s screen. To transfer control of your mouse and keyboard back to your computer, press Ctrl + Alt. If you have VMware Tools installed on the virtual machine, you can move the cursor in and out of the virtual machine to quickly switch mouse and keyboard control between the virtual machine and your computer.

There are several reasons why you might be unable to power on a virtual machine.

- You are missing the required libraries.
  
  To correct this problem, you must use a dependency checker such as ldd against libmks.so, viewer, and remotemks binaries. Take the following steps to determine the missing libraries.

  a. cd into ~/.mozilla/plugins
  b. ldd ./libmks.so | grep not
  c. ldd ./libmks.so | grep not
  d. ldd ./remotemks | grep not

  The output from steps b, c, and d indicate missing libraries. If these steps produce no output, all required libraries are available.

- You are running a non-GTK Mozilla browser.
  
  To correct this problem, use a GTK-based Mozilla browser, available at www.mozilla.org.
You are running a version of Firefox that came with your Linux distribution. Some distributions package Firefox incorrectly, and the resulting package does not work with VI Web Access.

To correct this problem, get the latest version of Firefox from [www.mozilla.org](http://www.mozilla.org).

**Entering Full Screen Mode**

When you select the Console tab, a full screen option is available. Select this option by clicking the full screen mode toolbar button (⋮) or by pressing Ctrl + Alt + Enter. This option is enabled only when a virtual machine is running and the Console tab is selected.

To exit full screen mode, press and release Ctrl + Alt.

**Installing VMware Tools in the Guest Operating System**

VMware Tools is a suite of utilities that improves the performance of guest operating systems and enhances virtual machine management. For best results, VMware strongly recommends that you install VMware Tools in all of your guest operating systems.

Once your guest operating system is installed on a virtual machine, follow the directions below for installing or upgrading VMware Tools.

**To install VMware Tools**

1. In the status section of a virtual machine’s summary, choose **Install VMware Tools**.

   The VMware Tools installer has been inserted into your virtual machine’s CD or DVD drive.

2. Use the console to complete the installation.

   This step connects the virtual machine’s CD drive to an installation file on the ESX Server machine or the VirtualCenter Server. If autorun is enabled in your guest operating system (the default setting for Windows operating systems), a dialog box appears after a few seconds. It asks if you want to install VMware Tools. Click **Install** to launch the Installation wizard.

3. Click the Console tab.

4. Restart the guest operating system when prompted.

**NOTE** You must restart the guest operating system to return the CD/DVD drive to its original configuration.
To upgrade VMware Tools

1. In the status section of a virtual machine’s summary, click **Upgrade VMware Tools**.

   The VMware Tools installer has been inserted into your virtual machine’s CD/DVD drive.

2. Use the Console to complete the installation.

3. When you are done, click the option **click here to eject the installer**.

Changing the Power State of a Virtual Machine

Depending on your permissions, you can use VI Web Access to change the power state of the virtual machine. To change a virtual machine’s power state, click the button in the toolbar that indicates the desired power state.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![red_square]</td>
<td>Powers off the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server might shut down the guest operating system before powering off the virtual machine (see “Changing Power State Options” on page 62). When this icon is red, the virtual machine is powered off.</td>
</tr>
<tr>
<td>![amber_square]</td>
<td>Suspends a running virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is amber, the virtual machine is suspended.</td>
</tr>
<tr>
<td>![green_square]</td>
<td>Powers on a stopped virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is green, the virtual machine is running.</td>
</tr>
<tr>
<td>![green_square]</td>
<td>Resets the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server might shut down the guest operating system before resetting the virtual machine (see “Changing Power State Options” on page 62).</td>
</tr>
</tbody>
</table>

**NOTE**

Shutting down or restarting a guest operating system works only when VMware Tools is installed. Otherwise, the power is turned off or the virtual machine is reset exactly as if you had pushed the power or reset button on a physical machine. For information on installing VMware Tools, see “Installing VMware Tools in the Guest Operating System” on page 27.
Creating and Sharing Remote Console URLs

Using VI Web Access, you can create a remote console URL of a virtual machine using ordinary Web browser URLs. When creating a remote console URL, you can customize the VI Web Access user interface controls, or use the remote console URL for personal use. Using remote console URLs, you can:

- Add the remote console URL to a list of favorite Web pages
- Share the remote console URL with one or more users in an email message

To create a virtual machine remote console URL

1. In the status section of a virtual machine’s summary, click Generate Remote Console URL.

   The Generate Remote Console URL page appears.

2. Choose user interface features.

   You can disable nonessential controls permanently. This allows a remote console URL user to concentrate on using the guest operating system.

3. Copy the remote console URL for further use.

4. Click Close to return to the Summary tab.
CHAPTER 5 Editing an Existing Virtual Machine’s Configuration

This chapter describes the various aspects of using VI Web Access to configure virtual machines. This chapter contains the following sections:

- “Editing the Configuration of Existing Virtual Machines” on page 31
- “Understanding Permissions and Virtual Machines” on page 31
- “Editing the Hardware Configuration of a Virtual Machine” on page 32
- “Adding Hardware to a Virtual Machine” on page 45
- “Changing Virtual Machine Options” on page 61

Editing the Configuration of Existing Virtual Machines

To see more information about a virtual machine and to modify its configuration, click the virtual machine in the Inventory panel. The Summary tab displays the activities you can perform when viewing a virtual machine’s details. These activities include:

- “Editing the Hardware Configuration of a Virtual Machine” on page 32
- “Adding Hardware to a Virtual Machine” on page 45
- “Changing Virtual Machine Options” on page 61

NOTE The virtual machine must be powered off before you can edit most configuration options.

Understanding Permissions and Virtual Machines

Access to a virtual machine is based on the permissions you, as a user, are granted to the virtual machine’s configuration file. Different permissions let you access virtual machines in different ways. These ways include:

- Browsing virtual machines
- Interacting with virtual machines
Configuring virtual machines

Administering virtual machines

Depending on your permissions and the state of the virtual machine, some options might not be available.

NOTE Permissions are configured using the Virtual Infrastructure Client. For more information, see the VMware Virtual Infrastructure Management Guide.

Editing the Hardware Configuration of a Virtual Machine

The Hardware list on the virtual machine Summary tab lists the virtual hardware in the virtual machine, such as memory, hard disks, CD/DVD drives, and network adapters. You can configure each hardware component, but frequently the virtual machine must be powered off to edit all of the component’s options.

Activities you can perform when editing the configuration of a virtual machine’s hardware include:

- “Editing Processors” on page 32
- “Editing or Removing a CD/DVD Drive” on page 33
- “Editing or Removing a Floppy Drive” on page 35
- “Editing a SCSI Controller” on page 37
- “Editing or Removing a SCSI Device” on page 38
- “Editing or Removing a Hard Disk” on page 39
- “Editing Memory Configuration” on page 40
- “Editing or Removing a Network Adapter” on page 41
- “Editing or Removing a Parallel Port” on page 42
- “Editing or Removing a Serial Port” on page 43

Editing Processors

You can change the number of virtual processors used by your virtual machine.

To change the number of processors used

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click Processors.

The available processor configuration options appear under Commands.
Chapter 5 Editing an Existing Virtual Machine’s Configuration

4 Click Edit.

The processor configuration page appears.

5 Choose the number of processors you would like for the virtual machine from the Processor Count drop-down menu.

6 Click OK to save your changes and to return to the Summary tab.

Editing or Removing a CD/DVD Drive

Virtual machines can access physical CD/DVD drives on either the ESX Server host where the virtual machine is running or on your computer. They can access ISO images on the ESX Server file system.

To edit an existing CD/DVD drive

1 Select the virtual machine you want to modify from the inventory panel.

2 In the Summary page, click the CD/DVD drive that you want to modify.

   The available CD/DVD drive configuration options appear under Commands.
3 Click **Edit**.

The CD/DVD drive configuration page appears.

The media source machine is selected at the top of the dialog box. Select an action:

- To connect the CD/DVD drive to the ESX Server devices or files, select **Host Media**.
- To connect the CD/DVD drive to devices on your computer, click **Client Media**.

**NOTE** The remainder of the dialog box contents changes to accommodate the capabilities of the selected media source. For example, virtual machines cannot connect automatically to client media while powering on. Consequently, the **Connect at power on** check box is disabled if the **Client Media** option is selected.

- To connect this virtual machine to the server’s CD/DVD drive when the virtual machine is powered on, select **Connect at power on**.

4 Specify whether to connect to the server’s CD/DVD drive or to an ISO image. Select **Physical Drive** or **ISO Image**.
Chapter 5 Editing an Existing Virtual Machine's Configuration

5 Enter the location of the drive or ISO image in the **Physical Drive** field.
   For example, the server's CD drive could be `/dev/cdrom`.
6 Select the IDE device node from the **IDE Device Node** list.
7 Click **OK** to save your changes and return to the Summary tab.

**To remove an existing CD/DVD drive**
1 Select the virtual machine you want to modify from the inventory panel.
2 Make sure the virtual machine is powered off.
3 On the Summary page, click the CD/DVD drive that you want to remove.
   The available CD/DVD drive configuration options appear under **Commands**.
4 Click **Remove**.

**Editing or Removing a Floppy Drive**

Virtual machines can access physical floppy drives on either the ESX Server host or on the computer on which you are running VI Web Access. They can access floppy image files on the ESX Server file system.

**To edit an existing floppy drive**
1 Select the virtual machine you want to modify from the inventory panel.
2 In the Summary page, click the floppy drive you want to modify.
   The available floppy drive configuration options appear under **Commands**.
3 Click **Edit**.

The floppy drive configuration page appears.

4 To connect this virtual machine to the server’s floppy drive, select **Connected**.

   **NOTE** Only one virtual machine can connect to a given floppy drive at a time.

   To connect this virtual machine to the server’s floppy drive when the virtual machine is powered on, select **Connect at power on**.

5 To specify whether to connect to the server’s floppy drive or to a floppy image, select **Physical Drive** or **Floppy Image**.

6 Enter the location of the drive or floppy image in the location field.

   For example, the server’s floppy drive could be `/dev/fd0`.

7 Click **OK** to save your changes and return to the Summary tab.

**To remove an existing floppy drive**

1 Select the virtual machine you want to modify from the inventory panel.
2 Make sure the virtual machine is powered off.
3 On the Summary page, click the floppy drive you want to modify.

   The available floppy drive configuration options appear under **Commands**.
4 Click **Remove**.
Chapter 5 Editing an Existing Virtual Machine’s Configuration

Editing a SCSI Controller

To edit a SCSI controller’s configuration

1. Select the virtual machine you want to modify from the inventory panel.
2. On the Summary page, click the SCSI controller you want to modify. The available SCSI controller configuration options appear under Commands.
3. Click Edit. 

   The SCSI controller configuration page appears.

4. Select the SCSI controller type in the list.

   **CAUTION** Changing the SCSI controller type might prevent the virtual machine from booting.

5. To specify whether the SCSI bus is shared, select the type of sharing in the SCSI Bus Sharing section:
   - **None** — Virtual disks cannot be shared by other virtual machines.
   - **Virtual** — Virtual disks can be shared by virtual machines on the same server.
   - **Physical** — Virtual disks can be shared by virtual machines on any server.

   Depending upon the type of sharing, virtual machines can access the same virtual disk simultaneously on the same server or any server.
Editing or Removing a SCSI Device

To edit an existing SCSI device

1. Select the virtual machine you want to modify from the inventory panel.
2. On the Summary page, click the SCSI device you want to modify.
   The SCSI device options appear under Commands.
3. Click Edit.
   The SCSI device page appears.

   ![SCSI Device 1 (SCSI 0:1)]

   **Device Status**
   - Connected
   - Connect at power on

   **Connection**
   Use the following physical device:
   `/dev/ide gatherings/8:0:0`

   **Virtual Device**
   SCSI Device Node: `0:1 SCSI Device 1`

   **Important Note**
   Some devices may not function properly if their virtual SCSI target numbers are different from their physical SCSI target numbers. For example, if the target number (i.e., the number following the colon) of the physical device is 3, only virtual SCSI node 0:3, 1:3, 2:3, or 3:3 will work.

4. Select Connect at power on to connect this virtual machine to this SCSI device when the virtual machine is powered on.
5. Use the drop-down menu under Connection to specify the physical device you want to use.
6. Use the drop-down menu under Virtual Device to specify the SCSI device node.
7. Click OK to update the SCSI device settings and return to the Summary Tab.

To remove an existing SCSI device

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3 On the Summary page, click the SCSI device you want to modify. The available SCSI device configuration options appear under Commands.

4 Click Remove.

**Editing or Removing a Hard Disk**

**To edit an existing hard disk**

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the hard disk you want to modify. The hard disk options appear under Commands.

3 Click Edit.

The hard disk page appears.

4 Select **Independent Mode**.
Select Persistent or Nonpersistent disk mode:

- **Persistent** — Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode is written out permanently to the disk.

- **Nonpersistent** — Changes to disks in nonpersistent mode are not saved to the disks. Changes are lost when the virtual machine is powered off or reset.

  Nonpersistent mode is convenient for users who always want to start with a virtual machine in the same state. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

Click OK to save your changes and return to the Summary tab.

**To remove an existing hard disk**

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the hard disk you want to modify.
   
   The available hard drive configuration options appear under **Commands**.
4. Click Remove.

**Editing Memory Configuration**

**To edit memory allocation**

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click **Memory**.
   
   The available memory configuration options appear under **Commands**.
4 Click Edit.

The memory device page appears.

5 To ensure that the virtual machine will boot, allocate at least the Recommended Minimum memory.

6 Click OK to update the memory setting and return to the Summary tab.

**Editing or Removing a Network Adapter**

Virtual network adapters can be connected to a labeled network in much the same way that physical network adapters are connected by cables to wall jacks. By choosing a labeled network for an adapter, you enable the guest operating system to reach the resources of the specified network.

**To edit an existing network adapter**

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the network adapter you want to modify.

   The available network adapter configuration options appear under Commands.

3 Click Edit.

   The network adapter page appears.
4 To connect this virtual machine to the network when the virtual machine is powered on, select **Connect at power on**.

- In the **Network Connection** list, select the virtual network device that you want the virtual machine to use.
- In the **Virtual Device** list, select the network driver that you want the virtual machine to use. Choose either the vlance or vmxnet driver.

5 Click **OK** to add the network adapter and return to the Summary tab.

**To remove an existing network adapter**

1 Select the virtual machine you want to modify from the inventory panel.
2 Make sure the virtual machine is powered off.
3 On the Summary page, click the network adapter you want to modify.
   
   The available network adapter configuration options appear under **Commands**.
4 Click **Remove**.

**Editing or Removing a Parallel Port**

**To edit an existing parallel port**

1 From the VI Web Access client, select the virtual machine.
2 On the Summary page, click the parallel port you want to modify.
   
   The available parallel port configuration options appear under **Commands**.
3 Click **Edit**.
   
   The parallel port page appears.
Chapter 5 Editing an Existing Virtual Machine’s Configuration

4 Under Device status, the default setting is Connect at power on.
   Clear the check box to deselect this setting.
   - If you select Physical, use the drop-down menu to choose the port that will be
     used on the end user’s host machine.
   - If you select File, type the path and filename, or browse to the location of the
     file.

5 Click OK to save the updated settings and return to the Summary tab.

To remove an existing parallel port
1 Select the virtual machine you want to modify from the inventory panel.
2 Make sure the virtual machine is powered off.
3 On the Summary page, click the parallel port you want to modify.
   The available parallel port configuration options appear under Commands.
4 Click Remove.

Editing or Removing a Serial Port

You can set up the virtual serial port in a virtual machine to use a physical serial port
on the host computer. This is useful, for example, if you want to use a modem or a
handheld device in your virtual machine.

To edit an existing serial port
1 Select the virtual machine you want to modify from the inventory panel.
2 On the Summary page, click the serial port you want to modify.
   The available serial port configuration options appear under Commands.
3 Click Edit.

The serial port page appears.

4 Under Device Status, the default setting is Connect at power on. Clear the check box to deselect this setting.
   - If you select Physical, use the drop-down list to choose the port that will be used on the end user's host machine.
   - If you select File, type the path and filename, or browse to the location of the file.
   - If you select Named Pipe, use the drop-down list to choose the connection options. Under Near End, select Is a server or Is a client. In general, select Is a server if you plan to start this end of the connection first.

5 If the kernel in the virtual machine's guest operating system uses the virtual serial port in polled mode (not interrupt mode) under I/O Mode, select the Yield CPU on poll check box.

6 Click OK to save the settings and return to the Summary tab.
To remove an existing serial port

1. Select the virtual machine you want to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary page, click the serial port you want to modify.
   - The available serial port configuration options appear under Commands.
4. Click Remove.

Adding Hardware to a Virtual Machine

You add virtual hardware to a virtual machine using the VI Web Access’s Add Hardware wizard.

To start the wizard

1. From VI Web Access, select the virtual machine.
2. From the Summary tab, under Commands, click Add Hardware.

3. Double-click the type of hardware you want to add.
4. Follow the steps in the wizard.

The following sections describe how to add virtual hardware to an existing virtual machine:

- “Adding a Hard Disk” on page 46
- “Adding a Network Adapter” on page 49
- “Adding a CD/DVD Drive” on page 50
- “Adding a Floppy Drive” on page 53
- “Adding a Serial Port” on page 54
- “Adding a Parallel Port” on page 58
- “Adding a SCSI Device” on page 60
Adding a Hard Disk

Hard disks are the only hardware that you can add to a virtual machine while the virtual machine is powered on.

To add a hard disk to a virtual machine

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under Commands, click Add Hardware.
   The Add Hardware wizard opens.
4. Choose the Disk Type:
   - Create a new virtual disk — Creates a new virtual disk and stores it on the host.
   - Use an existing virtual disk — Finds an existing disk stored on the host.
   - Use a mapped system LUN — Stores the data directly on a system LUN (logical unit number).
5. Click Next.

6. Specify the size and location of the disk.
   Disk size must be specified in integers only.

7. To install the virtual disk in the same location as the virtual machine, select Use the virtual machine’s datastore.
   
   **NOTE** This option is not available for legacy virtual machines.

8. To specify a datastore, type the path to the virtual disk, or click Browse and navigate to the directory you want to use.

9. Click Next.

The Advanced Options panel displays the SCSI device node and disk mode options.
10 Choose whether to run the disk in **Independent Mode**.

11 If you selected **Independent Mode**, select **Persistent** or **Nonpersistent** disk mode:

- **Persistent** — Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.

- **Nonpersistent** — Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in the same state. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

<table>
<thead>
<tr>
<th>The following device will be added to your virtual machine:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware Type:</strong></td>
</tr>
<tr>
<td><strong>Disk Type:</strong></td>
</tr>
<tr>
<td><strong>Capacity:</strong></td>
</tr>
<tr>
<td><strong>Location:</strong></td>
</tr>
<tr>
<td><strong>Mode:</strong></td>
</tr>
<tr>
<td><strong>Virtual Device Node:</strong></td>
</tr>
</tbody>
</table>

12 Review the device configuration summary and click **Finish** to complete the wizard.
Adding a Network Adapter

To add a network adapter

1. Select a virtual machine from the inventory panel.
2. From the Summary tab, under Commands, click Add Hardware.
   
   The Add Hardware wizard opens.

3. Double-click Network Adapter.

4. Select the network interface card, and select whether the system should connect the device when the virtual machine powers on.

5. Click Next.

6. Click Finish to add the network adapter.
Adding a CD/DVD Drive

The DVD or CD drives in the virtual machine can be used to read data from DVD or CD disks. You can add up to four DVD or CD drives to your virtual machine. You can connect the virtual machine's drive to a physical drive, to an ISO image on the host machine, or to a physical drive on the machine where you are running your browser.

To add a CD/DVD drive to a virtual machine

1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. From the Summary tab, under Commands, click Add Hardware.

   The Add Hardware wizard opens.

4. Double-click CD/DVD Drive.
5 Choose one of the Media Type options:

- Select **Use a physical drive** under Host Media to connect the virtual machine’s drive to a physical drive on the host computer.
- Select **Use an ISO image** under Host Media to connect the virtual machine’s drive to an ISO image file.
- Select **Use a physical drive** under Client Media to connect the virtual machine’s drive to a physical drive on your local machine.

6 Click **Next**.

7 If you selected **Use a physical drive** under Host Media, specify the drive you want to use and indicate whether the system should connect the device when the virtual machine powers on.

   ![Drive Selection](image)

   In order to access the selected media type, a disc must be in the drive specified below, and it must be connected to the virtual machine.

   **Physical Drive**
   ```
   \[\text{Device:}\]
   ```

   **Device Status**
   ```
   \[\text{Connect at power on}\]
   ```

8 Click **Next**.

9 If you selected **Use a physical drive** under Client Media, specify the drive you want to use.

   ![Physical Drive](image)

   **Physical Drive**
   ```
   \[\text{E:}\]
   ```

   **Device Status**
   ```
   \[\text{Connect at power on}\]
   ```
10 If you selected **Use an ISO Image** under **Host Media**, type the path and filename for the image file or click **Browse** to navigate to the file.

To have the drive connected to the virtual machine when you power it on, select **Connect at power on**.

11 Click **Next**.

The Advanced Options page appears.

12 Choose the virtual device node from the drop-down menu.

13 Click **Next**.

The **Ready to Complete** page appears and displays the device settings.

14 Click **Finish** to add the DVD or CD drive to your virtual machine.
Adding a Floppy Drive

You can connect a floppy drive in your virtual machine to a physical drive or floppy image on the host machine or to a physical drive on your computer. The resource backing a virtual floppy drive can be connected to only one virtual machine at a time.

**To add a new virtual floppy drive to a virtual machine**

1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. From the Summary tab, under **Commands**, click **Add Hardware**.

The Add Hardware wizard opens.

4. Double-click **Floppy Drive**.

---

**Hardware Type**

Which type of hardware do you want to install?

- Hard Disk
- Network Adapter
- CD/DVD Drive
- Floppy Drive
- Serial Port
- Parallel Port
- SCSI Device

---

**Media Type**

Floppy media can be accessed on the host system or on your local machine.

- **Host Media**
  - Use a physical drive
    - Choose this option to give the guest operating system access to a physical floppy drive on the VMware ESX Server system.
  - Use an existing floppy image
    - Choose this option to give the guest operating system access to a floppy image residing on the VMware ESX Server file system.
  - Create a blank floppy image
    - Choose this option to give the guest operating system access to a new, blank floppy image that will be stored on the VMware ESX Server file system.

- **Client Media**
  - Use a physical drive
    - Choose this option to give the guest operating system access to a physical floppy drive on your local machine.
Choose one of the Media Type options:

- Select Use a physical drive under Host Media if you want to connect the virtual machine's drive to a physical drive on the host computer.
- Select Use an existing floppy image under Host Media if you want to connect the virtual machine's drive to a floppy image file on the ESX Server file system.
- Select Create a blank floppy image under Host Media if you want to connect the virtual machine's drive to a new, blank floppy image file on the ESX Server file system.
- Select Use a physical drive under Host Media if you want to connect the virtual machine's drive to a physical drive on your local machine.

6. Click Next.

7. Select the type of floppy media. To have the floppy drive connected to the virtual machine when you power it on, select Connect at power on.

**NOTE** Connect at power on is not available with client media.

8. Click Finish to add the floppy drive to your virtual machine.

### Adding a Serial Port

You can set up the virtual serial port in a virtual machine to use a physical serial port on the host computer. This is useful, for example, if you want to use an external modem or a handheld device in your virtual machine.
Chapter 5 Editing an Existing Virtual Machine’s Configuration

To add a serial port to the virtual machine’s configuration

1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. From the Summary tab, under Commands, click Add Hardware.
   The Add Hardware wizard opens.
4. Double-click Serial Port.
   The Serial Port page appears.

5. Choose the connection type:
   - **Use a physical serial port** — Connects to a port on the end user’s host machine.
   - **Output file** — Sends serial port output to a file on the host computer.
   - **Use a named pipe** — Sends data from one application in a virtual machine to another application in a different virtual machine on the host computer.
6. Click Next.
7 To connect this virtual machine to the host’s serial port when the virtual machine is powered on, select **Connect at power on**, and click **Next**.

8 To connect this virtual machine to the host’s physical port when the virtual machine is powered on, select **Connect at power on**, and click **Next**.
9 Enter the location of the output file, or browse for a location in the Output File field.

To connect this virtual machine to the host’s output file when the virtual machine is powered on, select Connect at power on, and click Next.

10 To specify a named pipe, type the pipe name. Under Near End, select Is a server or Is a client.

In general, select Is a server if you plan to start this end of the connection first.
Under I/O Mode, select the **Yield CPU on poll** check box.

The kernel in the target virtual machine uses the virtual serial port in polled mode, not interrupt mode.

<table>
<thead>
<tr>
<th>The following device will be added to your virtual machine:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware Type</strong></td>
</tr>
<tr>
<td><strong>Connection Type</strong></td>
</tr>
<tr>
<td><strong>Connection Source</strong></td>
</tr>
<tr>
<td><strong>Connect At Power On</strong></td>
</tr>
<tr>
<td><strong>Yield CPU on poll</strong></td>
</tr>
</tbody>
</table>

Click **Next**.

Click **Finish** to add the serial port to your virtual machine.

### Adding a Parallel Port

Parallel ports are used by a variety of devices, including printers, scanners, dongles, and disk drives.

You can attach up to four parallel ports to a virtual machine. The virtual parallel port can connect to a parallel port or to a file on the host operating system.

**To add a parallel port to the virtual machine’s configuration**

1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. From the Summary tab, under **Commands**, click **Add Hardware**.

The Add Hardware wizard opens.
4 Double-click Parallel Port.

The Parallel Port page appears.

5 In the Device list, select System Parallel Port or Output File, and click Next.

6 Enter the location of the device in the Location field.

For example, the host's parallel port could be /dev/parport0.

7 To connect this virtual machine to the host's parallel port when the virtual machine is powered on, select Connect at power on, and click Next.

8 If you selected Output File, type the path and filename in the Output File field, or browse to the location of the file.
9 To connect this virtual machine to the host’s parallel port when the virtual machine is powered on, select **Connect at power on**, and click **Next**.

<table>
<thead>
<tr>
<th>Hardware Type</th>
<th>Parallel Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Type</td>
<td>Host parallel port</td>
</tr>
<tr>
<td>Connection Source</td>
<td>/dev/parport0</td>
</tr>
<tr>
<td>Connect At Power On</td>
<td>Yes</td>
</tr>
</tbody>
</table>

10 Click **Finish** to add the parallel port.

**Adding a SCSI Device**

**To add a SCSI device to a virtual machine’s configuration**

1 Select a virtual machine from the inventory panel.

2 From the Summary tab, under **Commands**, click **Add Hardware**.

The Add Hardware wizard opens.

3 In the Add Hardware wizard, double-click **SCSI Device**.

4 Under **Physical Device**, use the drop-down menu to select the physical device you want to use.
Chapter 5 Editing an Existing Virtual Machine's Configuration

5 To connect this virtual machine to this SCSI device when the virtual machine is powered on, select **Connect at power on**, and click **Next**.

6 Under **Virtual Device**, select the virtual device node where you want this device to appear in the virtual machine, and click **Next**.

7 Click **Finish** to add the SCSI device.

### Changing Virtual Machine Options

Configuration options let you adjust characteristics of the selected virtual machine, such as the virtual machine general settings, power options, and advanced options. The options are described in the following sections:

- “Changing General Settings” on page 61
- “Changing Power State Options” on page 62
- “Changing Advanced Settings” on page 63

#### Changing General Settings

The Options tab lets you adjust characteristics of the selected virtual machine. You must power off the virtual machine before you can make any changes.
To change general settings

1 In the Summary tab, in the Commands section, click Configure Options.

2 Click General.

The General Options options page appears.

3 To change the display name, type a new name in the Virtual Machine Name field.

4 To change the guest operating system installed on the virtual disk (for example, if you are upgrading the guest operating system), select the new guest operating system from the Guest Operating System list.

5 Click OK to save your changes and return to the Summary tab.

Changing Power State Options

Power state options allow you to define actions that occur in various virtual machine power states. You must power off the virtual machine before you can make any changes.
To change power state options

1. In the Summary tab, in the Commands section, click Configure Options.

2. Click Power.

   The Power Options page appears.

3. Choose the shutdown option for the virtual machine when the server is shut down.

   At system shutdown, settings for shutting down virtual machines include power off the virtual machine and shut down the guest operating system. By default, all virtual machines are powered off when the system shuts down. When VMware Tools is running, the virtual machine shuts down the guest operating system by default.

4. Choose the reboot option for the virtual machine when the server is shut down.

   At system shutdown, settings for rebooting virtual machines include reset the virtual machine and restart the guest operating system. By default, all virtual machines are rebooted when the system shuts down. When VMware Tools is running, the virtual machine restarts the guest operating system by default.

5. Choose to run a VMware Tools script either After resuming or Before suspending.

Changing Advanced Settings

To change advanced virtual machine configuration options, complete the following steps. You must power off the virtual machine before you can make any changes.
To change advanced settings

1. In the Summary tab, in the Commands section, click **Configure Options**.

2. Click **Advanced**.

   The Advanced Options page appears.

3. Select an option:
   - **Run with debugging information** — Runs the virtual machine with debugging information, which is useful when you are experiencing problems with this virtual machine. You can then provide this information to VMware support to troubleshoot any problems you are experiencing.
   - **Enable logging** — Enables logging for the virtual machine.
   - **Disable acceleration** — Disables acceleration in the virtual machine. You might want to temporarily disable acceleration in a virtual machine if you try to install or start a program in a virtual machine and the program seems to hang or crash or reports that it is running under a debugger. VMware has seen this problem with a few programs. Generally, the problem occurs early in the program's execution. In many cases, you can get past the problem by temporarily disabling acceleration in the virtual machine.

   This setting slows virtual machine performance, so use it only for getting past a problem with running the program. After you stop encountering problems, return to the virtual machine settings editor and deselect **Disable acceleration**. You might then be able to run the program with acceleration.
Index

A
Acceleration 63
Adding hardware 45
  CD/DVD drive 50
  floppy drive 53
  hard disk 46
  network adapter 49
  parallel port 58
  SCSI device 60
  serial port 54
Advanced options 63
Alarms 23

C
CD/DVD drive
  adding 50
  configuring 33
  removing 35
Configuring a CD/DVD drive 33
Configuring a floppy drive 35
Configuring a hard disk 39
Configuring a network adapter 41
Configuring a parallel port 42
Configuring a SCSI controller 37
Configuring a SCSI device 38
Configuring a serial port 43
Configuring advanced options 63
Configuring general options 61
Configuring memory allocation 40
Configuring power state options 62
Configuring processors 32

Connecting
  to ESX Server 5
  to VirtualCenter Server 5
Console 24

D
Debugging information 63
Default view 10

E
Events 22

F
Floppy drive
  adding 53
  configuring 35
  removing 36

G
General options 61

H
Hard disk
  adding 46
  configuring 39
  removing 40
Hardware configuration
  CD/DVD drive 33
  floppy drive 35
  hard disk 39
  memory 40
  network adapter 41
parallel port 42
processors 32
SCSI controller 37
SCSI device 38
serial port 43

I
Installation 4
Inventory view 17

K
Knowledge base ix

L
Logging 63
Logging in 9
Logging out 10

M
Memory configuration 40
Menu
View 13
Virtual Machine 13
Web Access 13
Menu bar 13

N
Network adapter
adding 49
configuring 41
removing 42

O
Options
advanced 63
general 61
power state 62
virtual machine 61

P
Parallel port
adding 58
configuring 42
removing 43
Passwords 6
Power state
toolbar actions 15
Power states
changing 28
current 21
options 62
Processors 32

R
Remote Console URLs 29

S
SCSI Controller 37
SCSI device
adding 60
configuration 38
removing 38
Serial port
adding 54
configuring 43
removing 45

T
Tasks 24
Tomcat 5
Toolbar 15
Troubleshooting 5

U
User groups ix
Index

V
View
  alarms 23
  console 24
  default 10
  events 22
  inventory 17
  tasks 24
  virtual machine summary 21
View menu 13
Virtual Infrastructure plug-in 6
Virtual machine alarms 23
Virtual machine console 24
Virtual machine events 22
Virtual machine memory
  configuration 40
Virtual Machine menu 13
Virtual machine options 61
Virtual machine summary 21
Virtual machine tasks 24
VMware community forums ix
VMware Tools 27

W
Web Access menu 13
Workspace 12
Updates for the Virtual Infrastructure Web Access Administrator’s Guide
ESX Server 3.0 and VirtualCenter 2.0

Last Updated: July 11, 2007

This document provides you with updates to ESX Server 3.0 and VirtualCenter 2.0 version of the Virtual Infrastructure Web Access Administrator’s Guide. Updated descriptions, procedures, and graphics are organized by page number so you can easily locate the areas of the guide that have changes. If the change spans multiple sequential pages, this document provides the starting page number only.

The following is a list of Virtual Infrastructure Web Access Administrator’s Guide page updates in this document:

“Updates for the About This Guide Discussion on Page vii”

Updates for the About This Guide Discussion on Page vii

The About This Guide section indicates that the Virtual Infrastructure Web Access Administrator’s Guide provides information on how to configure virtual machines for ESX Server and VirtualCenter Server. This is misleading in that the guide provides information on how to configure virtual machines only through Virtual Infrastructure Web Access.